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Thank you for choosing Philips.

Need help fast?

Read your Quick Start Guide and/or

User Manual first for quick tips

that make using your Philips product

\_

more enjoyable.
If you have read your instructions
and still need assistance,
you may access our online help at
www.philips.com/welcome
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Register online at www.philips.com/welcome today to

get the very most from your purchase.

Registering your model with PHILIPS makes you eligible for all of the valuable benefits listed below,so don't miss out.

Register online at www.philips.com/welcome to ensure:

*Product Safety Notification

*Additional Benefits

By registering your product, you'll receive notification - directly | Registering your product guarantees that you'll receive all of

from the manufacturer.

PHILIPS

Congratulations on your purchase,
and welcome to the “family!”

Dear PHILIPS product owner:

Thank you for your confidence in PHILIPS.You've selected one of
the best-built, best-backed products available today.We’'ll do every-
thing in our power to keep you happy with your purchase for many
years to come.

As a member of the PHILIPS “family,” you're entitled to protection
by one of the most comprehensive warranties in the industry.
What’s more, your purchase guarantees you'll receive all the
information and special offers for which you qualify, plus easy access
to accessories from our convenient home shopping network.

Most importantly, you can count on our uncompromising commit-
ment to your total satisfaction.

All of this is our way of saying welcome - and thanks for investing
in a PHILIPS product.

P.S. To get the most from your PHILIPS purchase, be
sure to register online at:

www.philips.com/welcome

the privileges to which you're entitled, including special money-
saving offers.

Know these

SafetYsymbols

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT
REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This “bolt of lightning” indicates unin-

sulated material within your unit may
cause an electrical shock. For the safety of
everyone in your household, please do not
remove product covering.

The “exclamation point” calls atten-

tion to features for which you should
read the enclosed literature closely to pre-
vent operating and maintenance problems.
WARNING: To reduce the risk of fire or
electric shock, this apparatus should not be
exposed to rain or moisture and objects
filled with liquids, such as vases, should not
be placed on this apparatus.
CAUTION: To prevent electric shock,
match wide blade of plug to wide slot, fully
insert.
ATTENTION: Pour éviter les choc élec-
triques, introduire la lame la plus large de la
fiche dans la borne correspondante de la
prise et pousser jusqu’au fond.

For Customer Use
Enter below the Serial No. which is locat-
ed on the rear of the cabinet. Retain this
information for future reference.

Model No.

Serial No.

PHILIPS

Visit our World Wide Web Site at http://lwww.philips.com/welcome




PHILIPS LIMITED WARRANTY
ONE (1) YEAR

WARRANTY COVERAGE:
PHILIPS warranty obligation is limited to the terms set forth
below.

WHO IS COVERED:

Philips warrants the product to the original purchaser or the per-
son receiving the product as a gift against defects in materials and
workmanship as based on the date of original purchase
(“Warranty Period”) from an Authorized Dealer. The original
sales receipt showing the product name and the purchase date
from an authorized retailer is considered such proof.

WHAT IS COVERED:

The Philips warranty covers new products if a defect in material
or workmanship occurs and a valid claim is received by Philips
within the Warranty Period. At its option, Philips will either (1)
repair the product at no charge, using new or refurbished
replacement parts, or (2) exchange the product with a product
that is new or which has been manufactured from new, or ser-
viceable used parts and is at least functionally equivalent or most
comparable to the original product in Philips current inventory,
or (3) refund the original purchase price of the product.

Philips warrants replacement products or parts provided under
this warranty against defects in materials and workmanship from
the date of the replacement or repair for ninety (90) days or for
the remaining portion of the original product’s warranty,
whichever provides longer coverage for you. When a product or
part is exchanged, any replacement item becomes your property
and the replaced item becomes Philips’ property. When a refund
is given, your product becomes Philips’ property.

Note: Any product sold and identified as refurbished or
renewed carries a ninety (90) day limited warranty.

Replacement product can only be sent if all warranty
requirements are met. Failure to follow all requirements
can result in delay.

WHAT IS NOT COVERED - EXCLUSIONS AND LIMI-
TATIONS:

This Limited Warranty applies only to the new products manu-
factured by or for Philips that can be identified by the trademark,
trade name, or logo affixed to it. This Limited Warranty does not
apply to any non-Philips hardware product or any software, even
if packaged or sold with the product. Non-Philips manufacturers,
suppliers, or publishers may provide a separate warranty for their
own products packaged with the bundled product.

Philips is not liable for any damage to or loss of any programs,
data, or other information stored on any media contained within
the product, or any non-Philips product or part not covered by
this warranty. Recovery or reinstallation of programs, data or
other information is not covered under this Limited Warranty.

This warranty does not apply (a) to damage caused by accident,
abuse, misuse, neglect, misapplication, or non-Philips product, (b)
to damage caused by service performed by anyone other than
Philips or Philips Authorized Service Location, (c) to a product or
a part that has been modified without the written permission of

Philips, or (d) if any Philips serial number has been removed or
defaced, or (e) product, accessories or consumables sold “AS IS”
without warranty of any kind by including refurbished Philips
product sold “AS IS” by some retailers.

This Limited Warranty does not cover:

 Shipping charges to return defective product to Philips.

* Labor charges for installation or setup of the product, adjust-
ment of customer controls on the product, and installation or
repair of antenna/signal source systems outside of the product.

* Product repair and/or part replacement because of improper
installation or maintenance, connections to improper voltage
supply, power line surge, lightning damage, retained images or
screen markings resulting from viewing fixed stationary con-
tent for extended periods, product cosmetic appearance items
due to normal wear and tear, unauthorized repair or other
cause not within the control of Philips.

» Damage or claims for products not being available for use, or
for lost data or lost software.

» Damage from mishandled shipments or transit accidents when
returning product to Philips.

* A product that requires modification or adaptation to enable
it to operate in any country other than the country for which
it was designed, manufactured, approved and/or authorized, or
repair of products damaged by these modifications.

* A product used for commercial or institutional purposes
(including but not limited to rental purposes).

* Product lost in shipment and no signature verification receipt
can be provided.

* Failure to operate per Owner’s Manual.

TO OBTAIN ASSISTANCE IN THE U.S.A., PUERTO
RICO, OR U.S. VIRGIN ISLANDS...
Contact Philips Customer Care Center at:

1-888-PHILIPS (1-888-744-5477)

TO OBTAIN ASSISTANCE IN CANADA...
1-800-661-6162 (French Speaking)
1-888-PHILIPS (1-888-744-5477) - (English or Spanish
Speaking)

REPAIR OR REPLACEMENT AS PROVIDED UNDER THIS
WARRANTY IS THE EXCLUSIVE REMEDY FOR THE CON-
SUMER. PHILIPS SHALL NOT BE LIABLE FOR ANY INCIDEN-
TAL OR CONSEQUENTIAL DAMAGES FOR BREACH OF
ANY EXPRESS OR IMPLIED WARRANTY ON THIS PROD-
UCT. EXCEPT TO THE EXTENT PROHIBITED BY APPLICABLE
LAW, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ON THIS PRODUCT
IS LIMITED IN DURATION TO THE DURATION OF THIS
WARRANTY.

Some states do not allow the exclusions or limitation of inciden-
tal or consequential damages, or allow limitations on how long an
implied warranty lasts, so the above limitations or exclusions may
not apply to you.

This warranty gives you specific legal rights. You may have other rights which vary from state/province to state/province.

Philips, P.O. Box 10313 Stamford, CT 06904

3140 035 50201
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Important

Safety

Important Safety Instructions
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Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.
Clean only with dry cloth.

Do not block any ventilation openings.
Install in accordance with the
manufacturer’s instructions.

Do not install near any heat sources such
as radiators, heat registers, stoves, or
other apparatus (including amplifiers) that
produce heat.

Do not defeat the safety purpose of

the polarized or grounding-type plug.

A polarized plug has two blades with
one wider than the other. A grounding
type plug has two blades and a third
grounding prong.The wide blade or the
third prong are provided for your safety.
If the provided plug does not fit into
your outlet, consult an electrician for
replacement of the obsolete outlet.

AC Polarized
Plug

Protect the power cord from being
walked on or pinched, particularly at
plugs, convenience receptacles, and the
point where they exit from the apparatus.

EN
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Only use attachments/accessories
specified by the manufacturer.

Use only with the cart, stand, tripod,
bracket, or table specified by the
manufacturer or sold with the apparatus.
When a cart is used, use caution when
moving the cart/apparatus combination to
avoid injury from tip-over.

b
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Unplug this apparatus during lightning
storms or when unused for long periods
of time.

Refer all servicing to qualified service
personnel. Servicing is required when
the apparatus has been damaged in any
way, such as power-supply cord or plug

is damaged, liquid has been spilled or
objects have fallen into the apparatus, the
apparatus has been exposed to rain or
moisture, does not operate normally, or
has been dropped.

Battery usage CAUTION —To prevent

battery leakage which may result in bodily

injury, property damage, or damage to the

unit:

* Install all batteries correctly, + and - as
marked on the unit.

*  Remove batteries when the unit is not
used for a long time.

*  Perchlorate Material-special handling
may apply. See www.dtsc.ca.gov/
hazardouswaste/perchlorate.

Apparatus shall not be exposed to
dripping or splashing, keep it away from
direct sunlight,naked flames or heat.



1N Warning

* Never remove the casing of this apparatus.

* Never lubricate any part of this apparatus.

* Never place this apparatus on other electrical
equipment.

¢ Keep this apparatus away from direct sunlight, naked

flames or heat.

Ensure that you always have easy access to the power

cord, plug or adaptor to disconnect this apparatus from

the power.

I\ Warning

¢ To avoid injuries, never put your fingers into the bass
pipe (1) or your hands into the aluminum ring (2).

Risk of overheating! Never install this apparatus
in a confined space. Always leave a space of

at least four inches around this apparatus for
ventilation. Ensure curtains or other objects
never cover the ventilation slots on this
apparatus.

Notice

Notice of compliance

Modifications

The user is cautioned that changes or
modifications not expressly approved by the
party responsible for compliance could void the
user's authority to operate the equipment.

FCC & RSS compliance statement

This device complies with Part 15 of the FCC
Rules and Industry Canada licence-exempt
RSS standard(s). Operation is subject to the
following two conditions:

@ This device may not cause harmful
interference, and

@ This device must accept any interference
received, including interference that may
cause undesired operation.

FCC Radiation Exposure Statement

This equipment complies with FCC’s and IC's
RF radiation exposure limits set forth for an
uncontrolled environment. The antenna(s)
used for this transmitter must be installed and
operated to provide a separation distance of
at least 20 cm from all persons and must not
be collocated or operating in conjunction with
any other antenna or transmitter. Installers must
ensure that 20cm separation distance will be
maintained between the device (excluding its
handset) and users.

FCC rules

This equipment has been tested and found

to comply with the limits for a Class B digital

device, pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable

protection against harmful interference in a

residential installation. This equipment generates,

uses and can radiate radio frequency energy
and, if not installed and used in accordance with
the instructions, may cause harmful interference
to radio communications. However, there is no

guarantee that interference will not occur in a

particular installation.

If this equipment does cause harmful

interference to radio or television reception,

which can be determined by turning the
equipment off and on, the user is encouraged
to try to correct the interference by one or
more of the following measures:

*  Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.

EN 7




Canada:
This Class B digital apparatus complies with
Canadian ICES-003.

Disposal of your old product and
batteries

Your product is designed and manufactured
with high quality materials and components,
which can be recycled and reused.

Never dispose of your product with other
household waste. Please inform yourself about
the local rules on the separate collection of
electrical and electronic products and batteries.
The correct disposal of these products helps
prevent potentially negative consequences on
the environment and human health.

Your product contains batteries, which cannot
be disposed of with normal household waste.
Please inform yourself about the local rules on
separate collection of batteries. The correct
disposal of batteries helps prevent potentially
negative consequences on the environment and
human heatth.

Please visit www.recycle.philips.con for
additional information on a recycling center in
your area.

Information about the use of batteries:

“ Caution

¢ Risk of leakage: Only use the specified type of batteries.
Do not mix new and used batteries. Do not mix
different brands of batteries. Observe correct polarity.
Remove batteries from products that are not in use for
a longer period of time. Store batteries in a dry place.

¢ Risk of injury:Wear gloves when handling leaking
batteries. Keep batteries out of reach of children and
pets.

* Risk of explosion: Do not short circuit batteries. Do
not expose batteries to excessive heat. Do not throw
batteries into the fire. Do not damage or disassemble
batteries. Do not recharge non-rechargeable batteries.

Environmental information

All unnecessary packaging has been omitted.
We have tried to make the packaging easy to
separate into three materials: cardboard (box),

polystyrene foam (buffer) and polyethylene
(bags, protective foam sheet.)

Your system consists of materials which can

be recycled and reused if disassembled by a
specialized company. Please observe the local
regulations regarding the disposal of packaging
materials, exhausted batteries and old equipment.

p
Made for

\iPod OiPhone [_]iPad
[al

AirPlay

“Made for iPod,"“‘Made for iPhone,” and “Made
for iPad” mean that an electronic accessory

has been designed to connect specifically to
iPod, iPhone, or iPad, respectively, and has been
certified by the developer to meet Apple
performance standards. Apple is not responsible
for the operation of this device or its compliance
with safety and regulatory standards. Please note
that the use of this accessory with iPod, iPhone,
or iPad may affect wireless performance.
AirPlay, iPod, and iPhone are trademarks of
Apple Inc, registered in the U.S. and other
countries. iPad is a trademark of Apple Inc.

Class Il equipment symbol:

ol

CLASS I apparatus with double insulation, and
no protective earth provided.

* The type plate is located on the bottom of the
apparatus.



http://www.recycle.philips.com

2 Your
Entertainment
System

Congratulations on your purchase, and
welcome to Philips! To fully benefit from the
support that Philips offers, register your product
at www.philips.com/welcome.

If you contact Philips, you will be asked for the
model and serial number of this apparatus. The
model number and serial number are on the
bottom of the apparatus.Write the numbers here:
Model No.

Serial No.

Introduction

Apple AirPlay technology enables you to play

your iTunes music library, hosted on a Mac, PC,

iPhone, iPod touch, or iPad on any AirPlay-

enabled device (for example, your DS3881W)

connected to the Wi-Fi network.

With an AirPlay-enabled device (for example,

your DS3881W), you can:

*  stream audio from your iTunes music
library to any room in your house

*  choose which AirPlay-enabled devices you
want to play music on (if you have more
than one such devices in your house)

*  stream audio to multiple AirPlay-enabled
devices at the same time (from the iTunes
music library on your PC/Mac only)

-

¢ Please visit www.philips.com/welcome for information
about more Philips AirPlay-enabled devices.

With DS3881WV, you can also:

*  charge your iPod/iPhone/iPad through the
USB socket with an Apple USB cable (not
supplied).

*  play your iTunes music library on your
iPod/iPhone/iPad through the USB socket
directly while charging.

*  play music from other audio devices
through the MP3-LINK socket.

What’s in the box

Check and identify the contents of your

package:

» DS3881W main unit (with a built-in Wi-Fi
module)

* 1 xAC power adapter

1 xMP3link cable

*  Charging stand

e User manual (in CD-ROM)

*  Quick start guide

What else you need

To stream audio wirelessly by AirPlay, you need:
*  AWi-Fi certified router
* A host for your iTunes music library,
for example, an iPod touch/iPhone/iPad
installed with iOS 4.3 (or later) or a Wi-Fi
enabled PC/Mac installed with iTunes 10
(or later)
Your DS3881W should be connected to the
same local network as your iTunes host device
through the Wi-Fi router.

List of compatible iTunes host devices
for AirPlay

In terms of AirPlay, DS3881W is compatible with:

*  aWi-Fi enabled PC/Mac installed with
iTunes 10 (or later); and

» the following iPod/iPhone/iPad models
installed with iOS 4.3 (or later):

e iPad2

e iPad

* iPhone 4

e iPhone 3GS

*  iPod touch (2nd, 3rd, and 4th generation)

EN 9



Overview of the main unit

A
|

Power indicator MP3-LINK
»  Connect an external audio player

A
® © J

0] . .
. Turm DS3881W on/off through the supplied MP3 link cable.
.l (® DCIN

»  Connect the power adaptor.
»  Start or pause play.

® © 06

+/-

e Adjust volume.

*  (Press and hold both buttons) reset
DS3881W.

Stand

® ©

USB <5
*  Connect an iPod/iPhone/iPad through
an Apple USB cable (not supplied).

(7) WI-FI SETUP button/indicator
*  Connect the unit to a Wi-Fi network.
*  Show the Wi-Fi connection status of
the unit.



Get started to use AirPlay

To get started with AirPlay, you need to:

1 Upgrade your iPod touch/iPhone/iPad to
the latest iOS version (iOS 4.3 or later).
*  Orinstall the latest version of iTunes
(iTunes 10 or later) on your PC/Mac.

2 Connect power to DS3881W, then turn it
on (see ‘Prepare’ on page 11).

3 Connect DS3881W to your existing home
Wi-Fi network.

4 Make sure that your iPod touch/iPhone/
iPad or PC/Mac are also connected to the
same Wi-Fi network.

EN 11



3 Prepare

Always follow the instructions in this chapter in
sequence.

Connect power

n Caution

Risk of product damage! Make sure that the power
supply voltage matches the voltage printed on the
bottom of the unit.

Risk of electric shock! When you unplug the AC
adaptor, always pull the plug from the socket. Never
pull the cord.

Before you connect the AC adaptor, make sure that you
have completed all the other connections.

DS3881W is designed with a built-in battery
that allows you to enjoy music on the go.
Before use, make sure to fully charge the built-in
battery.

12

Dock the DS3881W main unit on the
charging stand.

Connect the AC power cord to

» the DCIN socket on the back of the
charging stand.

*  the wall power socket.

EN
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* After AC power connection, if the built-in battery is full,

the power indicator on the front of the unit stays blue;
if the built-in battery is not full, the power indicator
flashes blue; if the battery is flat, the power indicator
turns red.

Turn DS3881W on

Press O on the top to turn the unit on.

Wait for successful boot-up of the unit.

% The boot-up takes about 35 seconds.

> During boot-up, the Wi-Fi SETUP
indicator on the back of the unit blinks
green quickly.

> After boot-up, if no Wi-Fi connection
has been set up for DS3881W, the
Wi-Fi SETUP indicator starts to blink
green slowly.

*  To turn the unit off, press O again.



4 Connect to
your home Wi-
Fi network for

AirPlay

To connect DS3881W to your existing home
Wi-Fi network, you need to apply your home
Wi-Fi setting to DS3881W.

You can do this in two ways (depending on
which type of Wi-Fi router you use):

Automatically - if your Wi-Fi router is WPS
(Wi-Fi Protected Setup)-enabled and
supports PBC (Push Button Connection)

(see ‘Scenario 1: Connect to a WPS router’

on page 13)

Manually - if your Wi-Fi router does not
support WPS (see ‘Scenario 2: Connect to
a non-WPS router’ on page 13)

Once connected successfully, DS3881W
will remember your home Wi-Fi settings.
Then you can enjoy AirPlay whenever
DS3881W is powered on and connected
to your home Wi-Fi network automatically.

Before connection of DS3881W to you home
Wi-Fi network, check the points below.

1
2

Make sure that your Wi-Fi router is
nowered on and working properly.

Make sure that DS3881W has been
cowered on and booted up successfully
(see Turn DS3881W on’ on page 12).
Identify the type of your Wi-Fi router (see
the user manual of your Wi-Fi router for
details).

Scenario 1: Connect to a
WPS router

¢ Before you press any button on DS3881W, make sure

that DS3881W has been booted up successfully (see
Turn DS3881W on'on page 12).

1

Press the WPS button on your home Wi-Fi
router.

Shortly after step 1, press Wi-Fi SETUP on

the back of DS3881W.

> The Wi-Fi SETUP indicator blinks red,
yellow and green alternately.

L Within 2 minutes, the WI-FI SETUP
indicator stops blinking and stays green,
and the unit beeps.
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L DS3881W is connected to your home
Wi-Fi network successfully.

5

* For some Wi-Fi routers, you may need to hold the
WPS button for Wi-Fi connection or enable the WPS
PBC function from the router configuration pages. See
the user manuals of the specific routers for details.

¢ If the Wi-Fi SETUP indicator on DS3881W blinks
yellow, it means that the Wi-Fi connection has failed.
Please wait for 2 minutes and try again. If the problem
remains, ry to set up the Wi-Fi connection manually
(see ‘Scenario 2: Connect to a non-WPS router' on
page 13).

* If the Wi-Fi connection fails again, press and hold both
the + and - buttons on the top of DS3881W to reset
it, and then try again.

Scenario 2: Connect to a
non-WPS router

* You can also follow the procedures below to connect
DS3881W to a WPS router manually.

14 EN

To connect DS3881W to a Wi-Fi router
manually, you need access to DS3881TW's
built-in configuration web page for change of
its internal Wi-Fi settings. To do so, you need a
Wi-Fi enabled device with an Internet browser
for temporary Wi-Fi connection to DS3881W.
The Wi-Fi enabled device can be an iPod touch/
iPhone/iPad or a Wi-Fi enabled PC/Mac.

Follow the sequence below for connection of
DS3881W to a non-WPS wi-Fi router.

1 Collect settings of your home Wi-Fi router
and write down on paper for use during
DS3881TW Wi-Fi setup (see ‘Collect
settings of your home Wi-Fi router’ on
page 14).

2 Switch DS3881W to Assisted Wi-Fi Setup
mMode (see ‘Switch DS3881W to Assisted
Wi-Fi Setup mode’ on page 14).

— A new Wi-Fi network created by
DS3881W will appear, with the
network name (SSID) of Philips Fidelio
AirPlay.

3 Connect your Wi-Fi enabled device to the
created new Wi-Fi network temporarily
(see ‘Connect your Wi-Fi enabled device
to the newly created Wi-Fi network’ on
page 15).

4 Open the built-in web page of DS3881W
with the Internet Browser of your Wi-Fi
2nabled device (see ‘Open the built-in web
page of DS3881W' on page 17).

5 Change the internal Wi-Fi settings of
DS3881W based on the settings you
wrote on paper at step 1 (see ‘Change the
internal Wi-Fi settings of DS3881W' on
page 1€).

6 Restore your Wi-Fi enabled device back
to your existing home Wi-Fi settings (see
‘Restore your Wi-Fi enabled device back
to your existing home Wi-Fi setting’ on
page 18).



Collect settings of your home Wi-Fi
router

Note

* Always consult the user manual of your home Wi-Fi
router for detailed instructions.

—

Connect your Wi-Fi enabled device to
your existing home Wi-Fi network.

2 Launch the Internet browser (for example,
Apple Safari or Microsoft Internet
Explorer) on your Wi-Fi enabled device.

3 Open the configuration page of your
home Wi-Fi router.

4 Find the Wi-Fi settings tab and write down
the following information on paper:

*  Press and hold Wi-Fi SETUP on the back

® Ngthork flame (5sID) of DS3881W for more than 5 seconds.
Wi-Fi security mode (usually WER L» The Wi-Fi SETUP indicator blinks
WPA or WPA2 if enabled) green and yellow alternately.
© Wi-Fi password (if Wi-Fi security is > A new Wi-Fi network created by
enabled) . DS3881W will appear, with the
@ DHCP mode (enabled or disabled) network name (SSID) of Philips Fidelio
@ Static IP address settings (if DHCP AirPlay.
mode is disabled) > It may take up to 45 seconds for

successful creation of this new Wi-Fi
Switch DS3881W to Assisted Wi-Fi network.
Setup mode

B
=1

* After you finish manual Wi-Fi setup for DS3881W,

¢ Before you press any button on DS3881W, make sure the new Wi-Fi network created by DS3881W will
that DS3881W has been booted up successfully (see disappear.

Turn DS3881W on' on page 12). If you fail to enter Assisted Wi-Fi Setup mode, power
off DS3881W and power on it, then try again after
successful boot-up.

* Make sure that there are no other Philips AirPlay-
enabled devices in Assisted Wi-Fi Setup mode at the
same time. Multiple Wi-Fi networks created this way
may interfere with each other.
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Connect your Wi-Fi enabled device to
the newly created Wi-Fi network

The new Wi-Fi network created by DS3881W
only allows access of one Wi-Fi enabled device.
To avoid interference from any other Wi-Fi
devices, you are recommended to temporarily
disable the Wi-Fi function on your other Wi-Fi
devices.

Option 1: Use your iPod touch/iPhone/iPad

1 Select Settings -> Wi-Fi on your iPod
touch/iPhone/iPad.

Settings

K3 erightness

ﬁ Wallpaper

&> General >

2 Select Philips Fidelio AirPlay from the list
of available networks.

16 EN

«tirg: | Wi-FI Networks

Philips Fidelio AirPlay

3 Wait until successful Wi-Fi connection on
your iPod touch/iPhone/iPad.
> = is displayed at the upper left corner
of your iPod touch/iPhone/iPad.

Tip

¢ If Philips Fidelio AirPlay is not in the list, try to scan the
available Wi-Fi networks again.

Use your Wi-Fi enabled PC/Mac

Note

* See the user manual of your PC/Mac for how to
connect your PC/Mac to a Wi-Fi network.

* During Wi-Fi network connection, do not connect any
network cable to your PC/Mac.

1 Open the Wi-Fi setup tool or control
panel on your PC/Mac.

2 Scan the available Wi-Fi networks.
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3 Select Philips Fidelio AirPlay from the list
of available networks.
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4 Wait until successful Wi-Fi connection on
your PC/Mac.
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Tip

¢ If Philips Fidelio AirPlay is not in the list, try to scan the
available Wi-Fi networks again.

Open the built-in web page of
DS3881W

1 Launch Apple Safari browser or any other
Internet browser on your Wi-Fi enabled
device.

2 Typein 192.168.1.1 at the browser
address bar and confirm.
> The DS3881W configuration web

page is displayed.
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192.168.1.1

hitpjfwewm. il cmnound
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If you use Safari on your Wi-Fi enabled PC/
Mac, you can also select ‘Philips_Fidelio XXX’
from the Bonjour pull-down list to enter the
DS3881W configuration web page directly.

1 Click % > Preferences.
> The Bookmarks menu is displayed.

] r_| —

Customize Taokar
Hide Menu Bar

b Hide Bookmarks Bar ~ ChrlShift+8
Hide Tab Biar Ctr+shift+T
Hide Status Bar Cirl+f
History Cirl+H
Dowrloads Clri+alt+.
Private Erowsing.
Reset Safari
Block Pop-lp Windows  CrrShift+

Help F1
Report Bugs to Apple.

Safari Extensions Gallery
About Safari

2 Tick Include Bonjour for Bookmarks bar.

HAg=TZa8 0

BEE A ety Diateces

3 Select ‘Philips_Fidelio XXX’ from the
Bonjour pull-down list shown at the
bookmarks bar.
> The DS3881W configuration web

page is displayed.

e

Borjour ¥ | Apple  ¥shoo!  Goo

About Bonjour

lilt

Philips_Fidelio

Change the internal Wi-Fi settings of
DS3881W

On the DS3881W configuration web page,
you can change the internal Wi-Fi settings of
DS3881W for connection of DS3881W to
your existing home Wi-Fi network.

Note

¢ Make sure that the settings on the configuration web
page match your home Wi-Fi network settings that you
wrote on paper.




192.168.1.1

Philps Fidefio s T

Welcome to Philips Fidelio AirPlay Wireless speaker
setup page. Follow the steps below to connect your
wireless speaker to the network.

Please select your WIFI network; [am, i
Please enter your network password: |

For advanced setup, please click Advanced;
‘otherwise, click Apply to proceed.

www.philips.com/welcome
© 2004 - 2011 Koninklijke Philips Electronics N.V.All rights
reserved.

< 2 m b

*  Follow the on-screen instructions to
change and confirm the internal Wi-Fi
settings of DS3881TW.
> After a while, the indicator on the back

of DS3881W stops blinking and stays
green, and the unit beeps.

> DS3881W is connected to your
existing home Wi-Fi network
successfully.

¢ If the WI-FI SETUP indicator on DS3881W does not
stay green steadily, it means that the Wi-Fi connection
has failed. Please power off both your Wi-Fi router
and DS3881W and then power on them again to see
whether DS3881W can be connected to your home
Wi-Fi network. If the problem remains, try the above
procedures again.

¢ After you finish the above changes or power-off and
power-on of DS3881W, the new Wi-Fi network
created by DS3881W will disappear:

3

* If you like, you can change the name of your DS3881W
in Advanced settings -> AirPlay Device Name on the
DS3881W configuration web page. This is helpful when
you have multiple Philips AirPlay-enabled devices in
your house and you need to distinguish between them.

* If you want to enter the network name (SSID) manually
(for example, if you want to hide your SSID), go to
Advanced settings -> CONFIGURE MANUALLY on
the DS3881W configuration web page.

Restore your Wi-Fi enabled device
back to your existing home Wi-Fi
setting

Note

* Make sure that the settings at steps 2 to 3 below match
your home Wi-Fi network settings you wrote on paper.

1 Select Settings -> Wi-Fi on your iPod
touch/iPhone/iPad.
*  Or open the list of available Wi-Fi
networks on your PC/Mac.
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3 Enter the network key if required.

4 Wait until successful Wi-Fi connection to
your home Wi-Fi network.

Settings

E Notifications

Carrier

K3 erightness

ﬁ Wallpaper

| General >

2 Select your network name (SSID) from the
list of available wireless networks.

settings  Wi-Fi Networks
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5 Play

Stream audio from your
iTunes music library to
DS3881W

Note

* Make sure that your iTunes host device is connected
to the same Wi-Fi network as DS3881W.Your iTunes
device can be an iPod touch/iPhone/iPad installed with
iOS 4.3 (or later) or a Wi-Fi enabled PC/Mac installed Cancel
with iTunes 10 (or later).

4 Select a media file and start play.
> After a while, you will hear music from
DS3881W.

Stream from your iPod touch/iPhone/
iPad

1 Launch the iPod application on your iPod 4= Symphony No_d (Schersa)
touch/iPhone/iPad.

2 Tap on the AirPlay icon.

@ * Symphony No. 9 (Scherzo)

¢ |1 Wl

A———

Note

* If you fail to hear music after successful setup, do one of
the following on your iPod touch/iPhone/iPad:
* (1) Disconnect and then re-connect to the same Wi-Fi
G router again;
* (2) Close all applications running at the background,
* (3) Power off and then power on your iPod touch/
iPhone/iPad again.

3 Select Philips_Fidelio XXXX (or user
customized name) from the AirPlay list.
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Stream from your PC/Mac

1 Launch iTunes 10 (or a later version) on
your PC/Mac.

2 Click the AirPlay icon on the window.

= = —_ =

Tip

* When you stream audio from your iTunes music library
on a PC/Mac, you can select more than one AirPlay-
enabled devices (if available) at step 3 to stream music
to all of them at the same time.

¢ If you are using an earlier version of iTunes, the AirPlay
icon may be £ instead of [al.

i

3 Select Philips_Fidelio_AirPlay XXXX (or
user customized name) from the AirPlay
list.

v L My Computer

4 Select a media file and start play.
> After a while, you will hear music from
DS3881W.

[
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Control play

You can select different play options from either
your iTunes host device or DS3881W.

Note

* Make sure that you have successfully streamed audio
from your iTunes music library to DS3881W.

* o pause or resume play, press » .
* o adjust volume, press +/- repeatedly.

Tip

* If you are streaming music from a PC/Mac, to control
music play from DS3881W, remember to tick Allow
iTunes audio control from remote speakers in Edit ->
Preferences -> Devices on iTunes.

Use advanced sound settings

If your iTunes host device is an iPod touch/
iPhone/iPad:

For advanced sound settings and additional
features, you can use your iPod touch/iPhone/
iPad to download the Philips Fidelio application
from Apple App Store. It is a free application
from Philips.

If your iTunes host device is a Wi-Fi enabled
PC/Mac:

For advanced sound settings, you can use the
equalizer available on iTunes directly (View ->
Show Equalizer).



E Ti *  the USB < socket on the back of
. DS3881W.
¢ See the iTunes help documentation for more details. ‘ . the dock connector on your iPod/

iPhone/iPad.
3

Play/charge your iPod/iPhone/ * With the built-in battery of DS3881W, you can play

H your iPod/iPhone/iPad on the go.

IPad thro ugh USB SOCket ¢ The built-in battery does not support charge of your
iPod/iPhone/iPad.

* The USB socket is only compatible with iPod/iPhone/

Pact Compatible iPod/iPhone/iPad

* To avoid possible damage to DS3881W, never try to
connect devices other than iPod/iPhone/iPad to the

The USB socket supports play and charge of

USB socket on DS3881W. the following iPod, iPhone, and iPad models.
e iPad2
* iPad

You can play or charge your iPod/iPhone/iPad

through the USB socket with an Apple USB ) !Phone 4
cable (not supplied). . !PhOﬂe 3GS
If you have stopped audio streaming by AirPlay, : fPhO”e 3G
after successful USB connection, the unit ¢ fPhO”e .
switches to the USB source automatically. * fPOd classic
*  iPod 5G
*  Pod 4G
*  iPod nano (2nd, 3rd, 4th, 5th, and 6th
generation)

*  iPod touch (1st, 2nd, 3rd, and 4th

@ generation)

Play from an external device

b You can also listen to an external audio player
,,,,,,, b through DS3881WV.
- s seror © If you have stopped both audio streaming by
AirPlay and direct music play through the USB
socket, DS3881WV switches to the MP3 link
source automatically.

*  Connect an Apple USB cable (not
supplied) to:
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*  Connect the supplied MP3 link cable to:
»  the MP3-LINK socket on the back of
DS3881W.
*  the headphone socket on an external
audio player.
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6 Update Update from the
firmware configuration page

'!‘ Warning

TO‘ |‘mprove the pen‘ormance of DS3881W, * Always connect your DS3881W to AC power for
Phl|lps may offer you new firmware for Upgrade firmware upgrade. Never power off your DS3881W
of your DS3881W. during firmware upgrade.

Please register your product at www.philips.
com/welcome for information about the latest
firmware.

Note

Note * To use an Internet browser other than Apple Safari
on your PC/Mac, remember to go to the Wi-Fi router
configuration page and write down the IP address of
your DS3881W. See the user manual of your Wi-Fi
router for how to find the IP addresses of devices
connected to the Wi-Fi router.

* You can only update the firmware from a PC/Mac.

Download the update file 1 Powe:;))n DS3881W (see ‘Prepare’ on
page 11).

o1 TR 1 L |t takes about 35 seconds for the unit

Qe : B0 s e to boot up. During boot-up, the WI-FI

bl 1) | WWW-phi”DS-Com/SUPPOft| I e I SETUP indicator on the back of the

: e |“ unit blinks green quickly.

> After boot-up, you can hear a beep
0 [88  united kingdom / English . and the WI-FI SETUP indicator
BRSSP T || 00X e turns to green steadily. DS3881W is
connected to the last configured Wi-Fi
network automatically.

Make sure that DS3881W and your PC/
Mac are connected to the same Wi-Fi
router.

N

| 3 Open Apple Safari on your PC/Mac, then
. select ‘Philips_Fidelio XXX’ from the
34 @ KRXX.zip Bonjour quTI-down list.
*  Or open any other Internet browser
1 on your PC/Mac, go to www.philips.com/ on your PC/Mac, then type in the IP
support. address of DS3881W (available on
the Wi-Fi router configuration page)
at the address bar.
5 The DS3881W configuration
web page is displayed.

2 Enter the model number to find the latest
firmware upgrade file available.

3 Saethe upgrade file to your hard drive.
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4

G

Follow the on-screen instructions to
complete the firmware update.

In case the firmware update fails, you can try the above
procedures again.

After successful firmware update, if there is any
problem with the Wi-Fi connection, press and hold
both the + and - buttons on DS3881W for more than
5 seconds at the same time to reset the device, and
then try to set up the Wi-Fi network for DS3881W
agair (see 'Connect to your home Wi-Fi network for
AirPlay’ on page 12).
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/ Product
information

Note

General information

AC power

Input: 100 - 240V~,
50/60 Hz 1A/1.2 A
Output: 12V =30 A

Operation Power
Consumption

3B5W

¢ Product information is subject to change without prior

notice.

Power Consumption in
Standby Mode

<05W

Specifications

Amplifier

Dimensions

- Main Unit 198 x 100 x 215 mm
(L xW x H)

Weight

- With Packing 1.95 kg

- Main Unit 1.32 kg

Rated Output Power

4 X 4W RMS

Frequency Response

63 - 20 kHz

Signal to Noise Ratio

>75dB

MP3 Link

650 mV RMS 20 kohm

Speakers

Speaker Impedance 8 ohm

Speaker Driver 40 mm full range
Sensitivity 78 dB/m/W
Wireless

Wireless 802.11b/g

standard

Wireless WEP (64 or 128 bit),
security WPA/WPA?2 (8-63 characters)
Frequency 2412 - 2462 MHz (CH1-
range CH11) (for /79,/37,1/55,197)

2412 - 2472 MHz (CH1-
CH13) (for /12, /10, /05)

PBC (one Yes
button push)
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8 Troubleshooting

'!‘ Warning

* Never remove the casing of this apparatus.

To keep the warranty valid, never try to repair
the system yourself.

If you encounter problems when using this
apparatus, check the following points before
requesting service. If the problem remains
unsolved, go to the Philips web site (www.
philips.com/welcome). When you contact
Philips, ensure that the apparatus is nearby
and the model number and serial number are
available.

No power

e Make sure that the AC power plug of the
device is connected properly.

*  Make sure that there is power at the AC
outlet.

*  Before you carry DS3881WV for use on the
go, make sure to fully charge the built-in
battery.

No sound

e Adjust the volume.

e Check the Wi-Fi network connection.
Set up the network again if needec (see
‘Connect to your home Wi-Fi network for
AirPlay’ on page 12).

No response from the unit

*  Press and hold both the + and - buttons
on DS3881W for more than 5 seconds
to reset the device. Then set up the
Wi-Fi network for DS3881WV again (see
‘Connect to your home Wi-Fi network for
AirPlay’ on page 12).

*  Disconnect and reconnect the AC power
plug, and then switch on the device again.

Wi-Fi network connection failed
e Check if your Wi-Fi router is Wi-Fi
802.11b/g certified. This device is only
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compatible with Wi-Fi 802.11b/g certified
routers.

e If your Wi-Fi router is Wi-Fi 802.11n
certified, make sure to enable the
802.11b/g mode. DS3881W does not
support connection to routers with
802.11n only.

*  This device does not support the WPS-
PIN method.

*  If your Wi-Fi router supports WPS and
the WPS-PBC method but fails to connect
to DS3881W, try the manual Wi-Fi setup
methoc (see ‘Scenario 2: Connect to a
non-WPS router on page 13).

*  Enable SSID broadcast on the Wi-Fi router.

*  Keep away from potential sources of
interference which may affect Wi-Fi signal,
such as microwave ovens.

*  If you fail to use your PC for Wi-Fi network
setup, check whether your PC is using a
Wi-Fi network.You cannot use Ethernet
connection for AirPlay network setup.

*  Make sure that the SSID name of your
home router consists of alphanumeric
characters, with no space or special
characters like %/#/* inserted.

* If you choose to rename the AirPlay device
‘Philips_Fidelio XXXX'in the setting
menu, do not use special characters or
symbols.

*  For some new types of Wi-Fi routers, a
network name (SSID) may be created
automatically when you use WPS for
connection. Always change the default
network name (SSID) to a simple one that
consists of alphanumerical characters, and
also change the Wi-Fi security mode to
secure your network.

Occasional breaking of AirPlay music

streaming

Do one or all of the following:

*  Move DS3881W closer to your Wi-Fi
router.

*  Remove any obstacles between DS3881W
and your Wi-Fi router.



e Avoid using Wi-Fi channel which is
overlapped by the nearby Wi-Fi network.

e Check if your network speed is fast enough
(in cases where multiple devices share the
same router, the AirPlay performance may
be affected). Turn off the other devices
connected to your home router.

*  Enable the Quality of Service (QoS)
option (if available on the Wi-Fi router).

*  Turn off other Wi-Fi routers.

No AirPlay icon on my iTunes host device

e Make sure that DS3881WV is already
connected to your home Wi-Fi network.

*  Before you open iTunes, make sure that
you have enabled Bonjour service in
your PC.Take Windows XP for example:
to enable the service, you can click
Start->Control Panel, and double-click
Administrative Tools-> Services->Bonjour
Service, then click Start followed by OK
on the pop-up menu.

e Ifthe problem remains, try to restart
DS3881W.

AirPlay connection failed with Mac or PC

e Temporarily disable the firewall and
security software to see whether it blocks
the ports that AirPlay uses to stream
content. See the help documentation of
your firewall and security software on how
to unblock the ports used by AirPlay.

*  When you use iPod Touch/iPhone/iPad/
Mac/PC for AirPlay, if the music play breaks
or stops, try to restart your iPod Touch/
iPhone/iPad, iTunes or DS3881W.

*  Video streaming or FTP downloads may
overload your router and therefore may
cause interruptions during AirPlay music
play. Try to reduce the load of your router.
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